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Installing

Preliminary Planning

About the discovery process

Discovery has been around for a long time. In the past, it involved primarily paper documents
that had to be searched through manually for privileged information or evidence. Today,
discovery largely involves electronically stored information (ESI), which is simply data that exists
in electronic format, stored in computers primarily as documents and e-mail. The question of
how to search and review ESI for evidence comes down to two options: print it out and review
it manually (slow and tedious) or put it into a database and review it on a computer (fast and
effective). That’s where Concordance comes in—it’s a database designed specifically for
reviewing documents electronically, a process made faster and easier by its robust search and
review features.

Electronic discovery (e-discovery) starts with data being identified and collected. When all
known discoverable data is collected, it needs to be processed by a tool such as LAW
PreDiscovery®, which puts all the data into a format that can be loaded into a Concordance
database. In this step, documents get scanned, electronic files get converted and/or extracted,
and the process of data filtering is completed (which can reduce thousands of documents down
to a few hundred). A data administrator can then load all this processed electronic data into
Concordance, Concordance Native Viewer, and Concordance Image where it gets reviewed and
analyzed and, finally, produced for opposing counsel and/or the defense team.
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Discoverable Data

Discoverable data is data that has been identified, preserved, and collected for a case that
becomes (after many hours of review and analysis) the facts and issues that you either have
to turn over to opposing counsel or use as evidence to defend your client. There are four
types of discoverable data that Concordance, Concordance Native Viewer, and Concordance
Image work with:

Paper documents

Electronic documents

E-mail

Transcripts and depositions

Electronic Documents

Concordance loads most electronic documents with ease, whether converted to tagged
image file format (TIFF) or in their native form (created by popular software programs such
as Microsoft Word, Adobe® Acrobat®, etc.). Documents loaded into Concordance in their
native form can be opened in Concordance Native Viewer or in the corresponding application
they were created in.  Whereas, Concordance Image can only open .tif files. All electronic
documents contain metadata that is  captured by the native application. However, additional
metadata can still be added manually, if necessary.

Native review can be done, provided you have the right software; however, using
Concordance Native Viewer or Concordance Image has the following benefits:

Consistent and reliable mark-up features for document review (redaction, highlights,
etc.)

Type comments/notes onto documents without defacing the original

Fast loading of document images

View any document or image, regardless of whether or not you have the native
application

E-mail 

Concordance makes it easy to import Microsoft® Outlook® e-mail messages (those with .pst
file extensions). Other types of e-mail, such as those from Lotus Notes, must be converted
before being loaded into Concordance, using a product such as LAW PreDiscovery (or using
a vendor).

Transcripts and Depositions

If a transcript or deposition is in electronic form, and is formatted correctly, it can be loaded
quickly and easily into Concordance, where you can review, tag, and add notes.

Paper Documents

Even in this electronic age, people still use paper to write notes, capture diagrams, and so



Concordance8

© 2018 LexisNexis. All rights reserved.

on. Additionally, letters, spreadsheets, reports and other documents created with computer
programs are often printed out and the original electronic document lost or destroyed. In
order for paper documents to be usable in Concordance, they must be scanned, to capture
both text and an image (picture) of the document, and coded, to capture additional
information such as author, document type, date created, and so on. This can be done using
a scanning and optical character recognition (OCR) tool such as LAW PreDiscovery.

Scanning

Paper is typically scanned into tagged image file format (.tif). For each TIFF, you’ll have a
corresponding file in the database, with matching serial numbers. A TIFF can be a single
page or multiple pages, just as a single document can be one or several pages in length. So,
not only are you be able to view the document as a TIFF in Concordance Native Viewer or
Concordance Image, you’ll be able to read the text of the document in Concordance.

Coding / Metadata

Electronic documents contain additional information about them, referred to as metadata,
which is data that is captured automatically by the software program, such as date created,
author, and so on. This data is highly searchable and of great value to you during document
review. However, because paper documents are scanned and lack this automatic coding,
they must be coded manually (although there are now software tools, such as ALCoder, that
can help speed up this process).

Preparing for Concordance

Preliminary planning for implementing any software application is important for achieving the
best setup results, the first time. We recommend that you take some time to review this
section to plan how your organization will be using Concordance so your administrative tasks
are minimized for initial setup and your long-term maintenance of the application is streamlined
into routine updates and adjustments, rather than reworking any database design and system
security later.

Discovery Document Conversion

If you are unfamiliar with the e-discovery process, we recommend that you take some time
to research this growing and rapidly changing industry and learn how it impacts your system
network and strategy by understanding how critical it is that data load files are handled
carefully during the import process. Because you are dealing with confidential materials, file
corruption of your database records is a sensitive matter and legal implications regarding
spoliation are strict and can carry hefty fines. Once data is altered, your ability to attain
another copy of case records in some instances is minimal – especially if it’s opposing
counsel’s case records – and can affect the lawsuit for the organizations involved.

For more information about the e-discovery process, see About the discovery process.

System Requirements
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Concordance’s system requirements for hardware and software are minimal and network
setup is flexible. The primary focus in ensuring that Concordance runs properly for you and
your organization is all about processing speed = RAM on your network and individual
workstations.

Please review the current system requirements for setup and suggested processor and RAM.
Keep informed of Concordance release updates and how they impact your system by
checking our Concordance Technical Support web site at http://lexisnexis.com/concordance,
which is accessible from the Workspace tab in Concordance.

For more information about Concordance system requirements, see System Requirements. 

Database Design

Engineered for capacity and speed, Concordance provides stability with its enormous
database capacity and robust security features. Designed with a flat-file architecture and a
proprietary back-end, Concordance can distribute and store data and processing over local-
area networks. With Concordance’s separate load and index processes, you can import a
variety of load files and their native file attachments, accessing them both in Concordance
and Concordance Native Viewer.

Proper review of your organization’s records for a given case helps determine how you build
and design your database structure. Concordance has some requirements for importing
certain types of records, especially emails and transcripts. Additionally, reviewing your case
load files provides you with a high level road map for how you want to move forward in
planning your database design.

Database design considerations are based on:

Possible database size – breaking record groupings into Database 1, Database 2,
Database 3

Document Type – email, native files, and transcripts

Confidential/Privileged Status

Content – Predetermined Subject Groupings

Rolling Production Environments – adding content to primary databases by creating
secondary databases and concatenating them

Other

For more information about Concordance databases and importing files, see About
Concordance databases and About importing files.

Security Setup

Security levels are predominantly affected by the size of your organization and the user
roles that constitute your review team. If your organization is large and has several
geographical locations, system security for multiple ongoing cases is going to take time and
forethought in planning. If you belong to a small organization, your system security may be
minimal for internal staff because users are more likely to perform many roles using
Concordance software.
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Please consider implementing security in your organization to ensure that records are
preserved in accordance with e-discovery regulations and database documents are secured
from inadvertent alteration or deletion by applying recommended user permissions for field
and menu items.

For more information about Concordance security and other settings, see About
Concordance security and  About view preferences.

Implementation Checklist

We understand that each organization has its own organization guidelines and processes
for supporting their review teams during case review. We also understand that transferring
to and implementing new technology may affect current procedures and that you may need
to adapt new ones given the demands of a rapidly changing e-discovery industry. Please
reference the Preliminary Planning Checklist to guide you in preparation for implementing
and maintaining Concordance at your workplace.

Preliminary Planning Checklist:

Checklist: Preliminary Planning

E-Discovery, Collection, and Processing

Do you have an understanding of e-discovery rules and how they affect your
specific case and the review process?

Do you have a collection and processing plan in place while also following
forensic guidelines, as required?

Do you have vendor relationships set in place for various stages of your case?

Do you have a quality control plan in place?

Do you know what types of files you are receiving and whether they are
recognized by Concordance?

Database Design

Do you know what your case dataset looks like?

What is the size of your case, including the # of pages/documents and GB to be
processed?

Will this case require a native review?

Do you understand what the case review workflow will be?

What kinds of fields are needed for tracking administration and reviewer
metrics?

What kinds of tags are needed for supporting administration maintenance?
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Checklist: Preliminary Planning

What fields are needed for coding additional metadata?

Where will annotations be tracked by reviewers: Concordance Image sticky
note, text associated note or field? If it’s a field, what fields need preparation for
annotations?

Do you have field and tag naming conventions set in place?

Do you have a list of categories for preparing your database tag structure?

Have you consulted key players involved with Concordance review and
administration regarding database design?

Have you prepared a directory location with subdirectory folders in a structure
that prepares you for optimal organization of the various files for the case?

Did you create extra miscellaneous fields in your database?

System Requirements

Have you reviewed the Concordance system requirements?

Have you given full network rights to all users in the directory where each case
resides?

Did you adjust the indexing and dictionary cache settings for each workstation?

Do you have remote staff that will be using Concordance offline remotely and
need a mobile license installed?

Security

Did you plan security settings for all users accessing this case?

Did you apply security to each Concordance database individually?

Did you store the security console user ID and password in a safe location and
share it with at least one other supervisor or administrator?

Maintenance

How will subsequent loads of data be handled? Will they be uploaded to the
main database or will you use concatenation to join multiple databases?

Do you have indexing/reindexing schedules planned based on the workflow and
timeline of the review?

Is there a back-up schedule in place?
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Checklist: Preliminary Planning

Do you have a quality control checklist for major administration tasks like
importing, exporting, and global edits?

Do you have a disaster recovery plan in place?

Production

Do you have a production plan in place for delivering files to opposing counsel?

Do you know what types of reports will be generated or requested by the
review team and how to print them?

Roles and Responsibilities

Does your review team understand the database design and know how they
will specifically use Concordance for review?

Does your review team understand timelines and processes required for
administrating and maintaining Concordance?

Are roles and responsibilities clearly defined among administrators, litigation
support staff, paralegals, and attorneys?

Are there policies in place for who can and cannot create/modify databases and
other sensitive tasks?

Ongoing Maintenance

As an administrator you are busy managing multiple cases and the various software
programs and databases in various network locations. We recommend you to take some
additional time to plan a maintenance schedule for Concordance depending on the
complexity of product licensing versions and how database structure is designed and
geographically dispersed.

Typical database management for Concordance includes:

Directory and subdirectory folder design to store multiple databases for multiple case
reviews within your organization

Back-up schedules for each case/multiple databases/concatenated databases

Full index updates on databases performed during off hours (weekends or holidays) or
offline if multiple databases can be updated while staff continues work in other
databases

Reindex updates when records are added or modified

Subsequent data and image loads

Deleting and packing databases and dictionary files after data entry/editing and indexing
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De-duplication

Replicating and synchronizing databases

Modifying or adding database fields, which then requires a full index

Tracking metrics

Running productions

Related Topics

About backing up databases
About archiving databases
About managing databases
About managing imagebases

System Requirements

Concordance System Requirements

Concordance’s system requirements for hardware and software are minimal and network setup
is flexible. The primary focus in ensuring that Concordance runs properly for you and your
organization is all about processing speed = RAM on your network and individual workstations.

Please review the current system requirements for setup and suggested processor and RAM.
Keep informed of Concordance release updates and how they impact your system by checking
our Concordance Technical Support web site at http://lexisnexis.com/concordance, which is
accessible from the Workspace tab in Concordance.

System Requirements: Concordance

The minimum system requirements for Concordance are:

Hardware and Software Minimum Recommended

Processor (CPU)

Dual 3GHz Xeon® or
Pentium HT (hyper-
threaded) processors or
higher

Dual 3GHz Xeon® or Pentium
HT (hyper-threaded)
processors or higher

Memory (RAM) 4GB 8 - 16GB

Hard Drive (Installation) 40GB of disk space or higher 40GB or disk space or higher

Supported Operating
Systems

(both 32- & 64-bit, all service
packs)

Microsoft® Windows Server
2008 R2

Microsoft® Windows Server
2008 R2, 2012, or 2012 R2 or
2016

http://lexisnexis.com/concordance
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File Storage (Images\Text
\Native Documents)

250GB 1TB

A disk caching, fault tolerant
RAID 1+0 array controller is
recommended for speed and
data integrity. 

Database Backend Microsoft® Windows Server
2008 R2

Microsoft® Windows Server
2008 R2, 2012, or 2012 R2 or
2016

Network Gigabit Gigabit

Software Required for
Proper Operation

Microsoft Outlook 2010 or
higher (32 bit)

.NET Framework 3.5 AND
4.0 or higher

Internet Protocol v4 (IPv4)

 Microsoft Outlook 2013 or
higher (32 bit)

.NET Framework 3.5 AND 4.0
or higher

Internet Protocol v4 (IPv4)
*IPv6 is not supported

In addition to the above, the following specifications are required:

Appropriate language packs installed

Computer should also meet the suggested requirements for the operating system being
used

Users must have full network permissions to write to database directory folders/files

Before installing Concordance on Windows Server 2008 R2 64-bit, make sure that the
server is up-to-date with the current Microsoft patches and the Microsoft .NET
Framework 4.0 is installed.

Concordance and FYI Server do not currently support the use of IPV6 for connecting to
databases on the FYI Server, only IPV4 is supported. Note that by default, Windows 10
(and later) and Microsoft Server 2012 (and later) automatically enable IPV6.  If you
need to disable IPV6, please refer to the the https://support.microsoft.com/en-us/
kb/929852 article on the  Microsoft web site. 

Network Setup

Concordance offers you administrative flexibility when installing the application, database,
and imagebase files. You have the option to place each on different servers, and even
different site locations. Concordance is still able to locate the files it needs to operate and
access database files.

A typical network installation includes:

Installing multi-seat licensing on LAN

Installing Concordance on applications and network servers

Installing the Workstation .exe on all workstations

Storing database files anywhere on LAN

Storing databases and images anywhere on LAN

Providing all users with full permission to database directory

https://support.microsoft.com/en-us/kb/929852
https://support.microsoft.com/en-us/kb/929852
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Allowing all users the ability to create/edit/delete, like Microsoft Word

Databases should be stored on a good network configuration with ample memory and
processing capabilities that allows write capacity. Images should be stored on a good
network configuration, but are large files that only need read access; don’t clog your best
server with image files unless they need to be linked. Ten to 100 MBPS may not be enough
for clients with large datasets.

The network version of Concordance must be installed on a network server drive. The
program will allow multiple users to concurrently access a database. The query sessions are
maintained in separate, temporary files, located in the user’s default directory or in the
directory identified by the TEMP environment variable. Each session is private and will not
affect any of the others. 

User Configuration Settings

Network user configuration information is stored in two places. Specific user preferences,
such as highlighting color and the default search operator, are saved in the workstation’s
system registry. For information on the registry key locations, see Registry key locations.
Specific database settings are stored in the database.ini file. Shared table layouts are
stored in the database’s home directory. 

In order to perform most of the database tasks, such as indexing, creating tags and
notes, importing data, modifying the database, and creating new databases, the user
must have Modify folder permissions to the folder where the database's .ini file is
located. For more information, please contact your Network Administrator or the
Windows Help and Support Center.

Network printing is handled by Microsoft Windows. Concordance will print to any printer
you have defined through Windows. 

Concordance has menu-option and database security. For additional information, see 
About Concordance security and About indexing databases.

Microsoft Windows Vista® Recommendations

When installing Concordance version 10.x on a server with client workstations attached,
using Microsoft Windows Vista as the operating system on the server is not
recommended. However, using Microsoft Windows Vista as the operating system on
workstations that point back to a server installation of Concordance version 10.x is
supported. 

It is also recommended not to create databases under the Windows Program Files folder,
since this is a protected location in Windows Vista. Similarly, when using Windows Vista it
is recommended to copy the sample databases (i.e., Cowco and Calfco) to a different
location when used by more than one user. If left under the Program Files folder,
database changes made by one user will not be visible to other users. 

Concordance version 10.x does function properly with Windows Vista UAC (User Account
Control) enabled.

You still need to create a shortcut .EXE file on each workstation.
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Databases that have linked files need to be stored in the same location on a server.

Cache Preferences

The system requirements for Concordance are minimal and you can reference a current
version listing in the Help system.

All processing occurs on the individual workstation. The processor and local RAM installed
have the greatest impact on searching, sorting, and indexing speeds. Your network, internet
connection speeds, and hard disk space will have some impact on the speed as well.

The cache preferences settings allow you to designate a specific amount of local RAM to
indexing and searching. These settings are stored in Window’s registry settings. 

We recommend modifying this number as it greatly improves your indexing speed. The more
RAM you have installed, the more you can designate to this indexing cache so Concordance
can process and perform indexing/reindexing faster. You will want to adjust this preference
setting on all indexing workstations.

Consider adjusting RAM to the following:

Increase total RAM 

Please note that the Microsoft Windows XP Service Pack 2 generally uses 160 MB RAM,
and Windows XP has a maximum RAM of 2 GB per process

Dictionary cache 

Memory used for dictionary functions like searching and sorting, creating the dictionary
.DCT file stored in the database registry defaults to 32 MB. We recommend setting it to 4
MB.

Index Cache formula

Total RAM – Operating System RAM – Dictionary Cache = Indexing Cache

Adjust your cache settings when you are installing Concordance on each individual
workstation that is used for indexing and reindexing. Make these changes before creating
your databases or importing your load files.

Indexing Speed Recommendations

We recommend giving Concordance as much memory as possible. Concordance allocates
memory to internal disk buffering during indexing. Any program that decreases the amount
of available memory, or performs background processing, could severely impact indexing
performance. The larger the database: the greater the impact. 

You can control the amount of cache, but be careful when allocating memory to the cache.
Windows has virtual memory that is stored on the hard drive when it is not being used. If
Concordance allocates a cache that forces too much swapping to disk, indexing will actually
run slower.

Indexing speed can be greatly improved by the following:

Using a disk-caching hard disk controller

Adding a faster hard disk
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Using a faster computer

Indexing on a Windows NTFS formatted hard drive. 

The highest performance is obtained by combining some or all of these options. There are
many recommendations on this subject. All but one has the effect of lowering the
workstation’s disk activity. We also recommend indexing individual databases on separate
machines.

Lower workstation disk activity by: 

Adding more cache RAM to your workstation and allocating this RAM to the Indexing
cache. 

You should leave 128MB unallocated and available for the Microsoft Windows 2000/XP
Professional/Windows 2003 Server operating system.

Get a faster processor for the workstation

Get a caching disk controller on the workstation

Use a level 1+0 RAID array with your disk caching controller

Implementing these suggestions will result in a significant boost in indexing performance.
Index cache and processor speed have the greatest impact. 

Installing Concordance

Before installing Concordance

Concordance Server is the version of Concordance that is typically installed on your shared
server. To install Concordance Server, you must run the Concordance<version#>_Install.exe file
from the server.

Make sure that you regularly back up your server data and strongly caution users to
regularly back up their data on the workstations. Do not install Concordance Server or
Concordance Workstation unless server data and workstation data has been backed up. 

Do not perform live backups if you are using backup software that locks files, even briefly.
This has been known to cause read/write functions to the database files to fail, and can
cause file synchronization or corruption issues. Check with your IT group and/or backup
solution provider to verify that no file locking occurs before scheduling any backups on
Concordance, Concordance Native Viewer, Concordance Image, and FYI files that are in
use.

Be aware that anti-virus, firewall, and backup software can often interfere with network
traffic and the locking of files, and in effect, could cause Concordance, Concordance Native
Viewer, Concordance Image, and FYI Server software to crash.

If you are installing the latest version of Concordance and have Concordance 10.7 or
earlier installed, you must uninstall the older version before proceeding with the
installation to ensure that the application files are accessible to Concordance. You do not
need to uninstall versions 8.x or 9.x of Concordance. 
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The default install directory for the Concordance application data files is C:\Documents and
Settings\All Users\Application Data\LexisNexis\Concordance [version #] (Windows XP) or C:
\ProgramData\LexisNexis\Concordance [version #] (Windows 7).

When you uninstall a previous version of Concordance, the CPL and Databases folders
associated with the previous version are not removed.  If you want to remove these
folders, make sure that you back up the folders and then manually delete them.

Before installing Concordance, be sure to review the following information about Concordance
licensing, system requirements, installation changes, and database compatibilities.

Licensing

Concordance provides licensing options to fit your needs. For detailed information, please
contact Concordance Sales at 1-800-453-6862 or e-mail 
LitigationSalesGroup@ReedElsevier.com.

Installation Changes for Version 10.x:

With Concordance version 10.x, there are some installation changes:

Concordance version 10.x installs to a new default folder, …\LexisNexis\Concordance 10.

Concordance version 10.08 installs application data to a new default folder and creates a
shortcut on your desktop: C:\Documents and Settings\All Users\Application Data\LexisNexis
\Concordance 10 (Windows XP) or C:\ProgramData\LexisNexis\Concordance 10 (Windows 7).

Concordance has a new entry, Concordance 10, in the Add or Remove Programs dialog
box 

Concordance has new locations for the registry keys. 

For more information about the registry key locations, see Registry key locations.

These changes allow Concordance version 8.x, Concordance 2007, and Concordance version
10.x to coexist on the same computer.

Database Compatibility

Due to the major database structure changes required by the Unicode Standard, all
databases need to be converted to version 10 or later. Earlier database versions cannot be
opened in Concordance version 10. Only database versions 7.x, 8.x, or 9.x can be converted
to version 10.x. 

Since there is no backwards compatibility to older database versions in Concordance version
10.x, opening a database version 7.x, 8.x, or 9.x prompts the user to convert the database
to version 10.x. If the user chooses not to convert to version 10, the database will not open
in Concordance version 10.x.

For more information about converting databases, see Converting databases. 

Concordance version 10.x databases and Concordance Image version 5.x imagebases
are not compatible with Concordance FYI Server version 3.53 or earlier and FYI

mailto:LitigationSalesGroup@ReedElsevier.com
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Reviewer version 3.55 or earlier. Concordance 10.x databases and Concordance Image
5.x imagebases are compatible with FYI Server and FYI Reviewer versions 4.x or later.

DDE Commands and Concordance

DDE stands for Dynamic Data Exchange. It allows two applications to communicate through
programmed commands in the Windows environment. It is not a simple interface and it
should only be used by experienced programmers.

The examples given here are provided for the C programming language. There are four
types of DDE commands that Concordance will recognize. The first command establishes the
link between your program and Concordance. This is referred to as opening a DDE
conversation. 

Establishing a DDE conversation

All DDE conversations are established by connecting to the DDE server, Concordance.
Establishing the conversation requires your program to provide two parameters: the
service and the topic. The service is the name of the DDE server, in this case Concordance.
The topic is defined by the service and it varies from server to server. Concordance
supports database names as topics. The database topic should use the full file path in
either standard or UNC format. Concordance opens the database specified as the topic
for use in the DDE conversation. Use an asterisk, *, as the topic to open the conversation
using any database currently open and in use by an end-user. You can close that
database later and open another using the DDE Execute commands.

Example

The following example is written in C. It opens a DDE conversation with a Concordance
server. The OpenConcordanceDDE() function receives two parameters: the instance
identifier and the database name. The instance identifier, idInst, is a value returned by
DdeInitialize() when your program performed the required DDE initialization. The
pszDatabase parameter is a pointer to a zero terminated string containing the name of
a database to open, or NULL to open the DDE conversation based on the currently
open database, i.e., using * as the topic.

HCONV OpenConcordanceDDE( DWORD idInst, char *pszDatabase)

{

HSZ hszService,  // Name of service to connect.

             hszTopic;  // Topic of conversation.

HCONV  hConv;  // Handle to DDE conversation.

             // Set the handle to a NULL value.

             hConv = NULL;

             // Use the database name if provided, otherwise

             // use * if no database is specified, this will
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             // open the DDE conversation using the current

            // database being viewed by the end-user.

            if (pszDatabase == NULL)

            pszDatabase = "*";

            // Create the service’s string handle.

            hszService = DdeCreateStringHandle(idInst,

                                                                       "Concordance",

                                                                       CP_WINANSI);

             // Create the topic’s string handle.

             hszTopic = DdeCreateStringHandle(idInst,

                                                                     pszDatabase,

                                                                     CP_WINANSI);

             // Connect to the service, Concordance.

             hConv = DdeConnect( idInst,

                                                 hszService,

                                                 hszTopic,

                                                 (PCONVCONTEXT)NULL);

             // Free the DDE string handles.

             DdeFreeStringHandle(idInst, hszService);

             DdeFreeStringHandle(idInst, hszTopic);

             // Return the handle to this DDE conversation.

             // The handle is required for all further

             // communication with the Concordance DDE server.

             return(hConv);

}
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Once a DDE conversation has been established, all further communication between your
program and Concordance takes place through the Microsoft Windows’
DdeClientTransaction() function. The DdeClientTransaction() function has eight
parameters:

       DdeClientTransaction( void *lpvData,

                                                  DWORD cbData,

                                                  HCONV hConv,

                                                  HSZ hszItem,

                                                  UINT uFmt,

                                                  UINT uType,

                                                  UINT uTimeout,

                                                  DWORD *lpuResult);

Any parameters used in communicating with Concordance are referenced by name. For
more information, see the DDE Execute, DDE Request, and DDE Poke commands sections.
The function and associated data types are fully documented in Microsoft’s C
Programming Language Reference.

The other commands tell Concordance to do something, or they send or receive data. These
commands are called:

DDE Execute commands

Execute commands request Concordance to perform actions. These include moving
between records, performing a search, appending and deleting records, and opening and
closing databases. These commands return success codes, but they do not return data.

Commands with Parameters

Several commands contain two parts: the command and the command parameter. For
instance, opening a database also requires the name of the database you want to open.
The command is sent as the single string open drive:path\filename.dcb.

DdeClientTransaction() Parameters

Execute commands use two DdeClientTransaction() parameters, lpvData and cbData.
lpvData is a pointer to the command string. This may simply be the command string in
quotes. cbData is the number of bytes in the command string, lpvData, including the
terminating zero. For instance, strlen(lpvData) + 1.

Returns

The XTYP_EXECUTE commands return DDE_FACK, DDE_FBUSY, or DDE_FNOTPROCESSED.
DDE_FACK and DDE_FBUSY are returned to indicate success or TRUE and failure or FALSE.
For instance, the lock command returns DDE_FACK if the record was successfully locked
and DDE_FBUSY if it could not be locked, i.e., someone else already has it locked.

DDE_FNOTPROCESSED is only returned if the command is not recognized, usually due to a
misspelling, or if the database is not open. The return codes are defined in the Windows
ddeml.h include file, provided with your compiler.
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EXECUTE Commands

C
o
m
m
a
n
d

Parameter Function

a
p
p
e
n
d

Appends the current record to the end of the database. This is
generally used with blank, to create a new record. For E-
documents databases created using Concordance version 10.21
and later, this function is disabled.  To append a document to an
E-documents database, drag the document onto the database.

b
l
a
n
k

Creates a blank record. If the current record has been edited, it is
automatically saved before being blanked. Use blank records with
the append command to add records to the database.

b
r
o
w
s
e

Brings up the Browse screen.

c
l
o
s
e

Closes Concordance. This also terminates the DDE conversation.

c
l
o
s
e
d
a
t
a
b
a
s
e

Closes the current database.
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EXECUTE Commands

C
o
m
m
a
n
d

Parameter Function

c
l
o
s
e
a
l
l
d
a
t
a
b
a
s
e
s

Closes all open databases.

f
i
r
s
t

Retrieves the first record in the query.

g
o
t
o

FIELD = VALUE This performs a search for the record whose field exactly matches
the value. The search is not limited to the current query set, it
looks throughout the database. Wildcards and Boolean logic are
not allowed in the query. The field must be a key field. The
matching record is retrieved, but a new query is not incremented.

Record number Moves to any record in the current set of retrieved records.

g
o
t
o
r
e
f
e
r
e
n
c

/d=database /
k=key /
o=offset /
l=length

This opens a specific database specified by database, goes to a
key (the replication key) specified by key, and highlights a range of
characters specified by the offset and length. database is the full
path to the database.dcb file. key is the replication key. offset is
the offset in characters to start highlighting from. length is the
number of characters to highlight.
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EXECUTE Commands

C
o
m
m
a
n
d

Parameter Function

e

i
s
d
e
l
e
t
e
d

Checks if the record is marked for deletion.

i
s
e
d
i
t
e
d

Checks if the record has been edited since last indexed or
reindexed.

l
a
s
t

Moves to the last record in the current set.

l
o
c
k

Locks the current record so that you can edit it.

n
e
x
t

Moves to the next record.

o
p
e
n

Database path. Opens a database.

p
g

Moves to the next record for Browse or Table views. It is not
necessary to send a repaint command after a pgdn.
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EXECUTE Commands

C
o
m
m
a
n
d

Parameter Function

d
n

p
g
u
p

Moves to the previous record for Browse or Table views. It is not
necessary to send a repaint command after a pgup.

p
r
e
v

Moves to the previous record.

r
e
p
a
i
n
t

Updates the Browse or Table display. Use this if your program
changes the contents of the displayed record, or moves to another
record.

s
e
a
r
c
h

Search string. Executes a search.

u
n
l
o
c
k

Unlocks the record.

s
e
t
f
o
c
u
s

Concordance sets focus to itself. This is equivalent to the Windows
SetFocus() function.
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EXECUTE Commands

C
o
m
m
a
n
d

Parameter Function

t
a
b
l
e

Places Concordance into Table view.

z
a
p

The database is zapped. Every record in the database is erased
and permanently deleted.

DDE Request commands

DDE request commands return data values. This group of Concordance DDE commands
returns information about the database, such as a list of fields or the database’s name,
as well as the field contents.

DdeClientTransaction() Parameters

hszItem is a string handle created with DdeCreateStringHandle() and it contains the
command string in CP_WINANSI format. Use the CF_TEXT format for field names when
retrieving data from the database fields. Field names must be in all upper case. Set uFmt
to either CP_WINANSI or CF_TEXT as appropriate.

Returns

XTYP_REQUEST commands return an HDDEDATA value containing the requested
information. Use DdeGetData() to both obtain the length of the data and to copy it to
local memory. Note that the data may not be terminated with a zero. Allocate one extra
byte to your buffer before you copy the returned data. Null terminate the string yourself.

Numeric fields are returned as text strings. Date fields are returned in YYYYMMDD format.

REQUEST Commands

Command Data Returned

Database status This command returns information about the database in eight
lines of text, delimited with carriage returns and line feeds. Each
line contains a number indicating:



Installing 27

© 2018 LexisNexis. All rights reserved.

REQUEST Commands

Command Data Returned

Records in the database

Fields in the database

Needs reindexing

Current physical record number

Current record number in the query

Active query number

Records in the query

Total queries

Database name The full path and file name of the database.

List of Fields A list of fields in the database. Each field is on a line terminated
with a carriage return and a line feed. The field name is followed
by six items indicating:

The field type: P, N, D, or T.

The field’s length.

The decimal places, applies to numeric fields.

A Y(es) or N(o) to indicate if it is a key field.

A Y(es) or N(o) to indicate if it is an image field.

Image field The contents of the image field, if an image field has been
defined, otherwise NULL is returned.

Total count A string containing the count of all records in the database,
including any concatenated databases.

Query count A string containing the number of records in the current query.

FIELD The contents of the named field.

DDE Poke commands

DDE Poke commands send data to a Concordance field. The new data replaces any data
already in the field. Data on the end-user’s screen is not updated unless you send a
repaint message.

DdeClientTransaction() Parameters
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hszItem is a string handle created with DdeCreateStringHandle() and it contains the
name of the field that will receive the data. You must set uFmt to CF_TEXT and use the
CF_TEXT format to create hszItem. lpvData points to the data for the field, and cbData is
the length of the data in bytes, i.e., strlen(lpvData). The data does not need to be a zero
terminated string.

All data is sent as text strings, including values for numeric fields. Data destined for a
date field must be in YYYYMMDD format, without slashes or any punctuation. For instance,
19991231 is valid but 31/12/1999 is invalid.

Returns

DDE_FACK if the data was accepted. DDE_FNOTPROCESSED is returned if the command
failed because:

the field was not found

the data format was not CF_TEXT

the database isn't open

you do not have sufficient security rights to change the field’s contents

DDE_FBUSY is returned if the record is not locked and Concordance could not lock it to
complete the command.

Installing Concordance

Concordance Server is the version of Concordance that is typically installed on your shared
server. To install Concordance Server, you must run the Concordance<version#>_Install.exe file
from the server.

LexisNexis offers an evaluation version of Concordance Server. The evaluation version of
Concordance Server is the same software as the full version, except the evaluation version has
a 30-day limit. The evaluation version can be installed on your shared server. The installation
process is similar to the full version but the serial number and activation code are not entered. 

When you purchase Concordance, you receive a serial number and activation code, which you
can use to convert the evaluation version to the full version of the software. You will not need
to re-install the software.

If you are installing the latest version of Concordance and have Concordance 10.7 or
earlier installed, you must uninstall the older version before proceeding with the
installation to ensure that the application files are accessible to Concordance. You do not
need to uninstall versions 8.x or 9.x of Concordance. 

The default install directory for the Concordance application data files is C:\Documents and
Settings\All Users\Application Data\LexisNexis\Concordance [version #] (Windows XP) or C:
\ProgramData\LexisNexis\Concordance [version #] (Windows 7).

When you uninstall a previous version of Concordance, the CPL and Databases folders
associated with the previous version are not removed.  If you want to remove these
folders, make sure that you back up the folders and then manually delete them.
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Make sure that you regularly back up your server data and strongly caution users to
regularly back up their data on the workstations. Do not install Concordance Server or
Concordance Workstation unless server data and workstation data has been backed up. 

Do not perform live backups if you are using backup software that locks files, even briefly.
This has been known to cause read/write functions to the database files to fail, and can
cause file synchronization or corruption issues. Check with your IT group and/or backup
solution provider to verify that no file locking occurs before scheduling any backups on
Concordance, Concordance Native Viewer, Concordance Image, and FYI files that are in
use. 

Be aware that anti-virus, firewall, and backup software can often interfere with network
traffic and the locking of files, and in effect, could cause Concordance, Concordance Native
Viewer, Concordance Image, and FYI Server software to crash.

When installing Concordance version 10.21, please note that the new E-Documents import
wizard is only compatible with the full installed version of Concordance.  This feature is not
available for a Concordance Workstation installation.

To install the full version of Concordance:

1. Run Concordance10_Install.exe directly on the shared server. 

If you are installing the latest version of Concordance and have Concordance 10.7 or
earlier installed, you will be prompted to uninstall the older version and then install
Concordance 10.08.

When you uninstall a previous version of Concordance 10.07 or earlier, the CPL and
Database folders associated with the previous version are not removed.  If you want to
remove these folders, make sure that you back up the folders and then manually delete
them.

2. The Welcome dialog box appears. Click Next. 
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3. The Setup Type defaults to Install Concordance 10 Application, and then click Next. 
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4. Type the Serial Number and Activation Code you received when you purchased
Concordance to activate Concordance, and then click Next.

If you want to purchase new Concordance licenses, or cannot find your Concordance
serial number and activation code, contact Concordance Support at 1-866-495-2397 or
e-mail concordancesupport@lexisnexis.com.

To activate Concordance at a later time, click the Skip Activation button and click Next. An
evaluation version of Concordance will be installed. For more information, see To install
the evaluation version of Concordance Server. 

Concordance can be activated later from the Activate Concordance command on the
Help menu. For more information, see To activate Concordance.

mailto:concordancesupport@lexisnexis.com


Concordance32

© 2018 LexisNexis. All rights reserved.

 

5. To print the End-User License Agreement, click Print. To agree to the End-User License
Agreement, click Yes.
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6. The default folder for Concordance is C:\Program Files\LexisNexis\Concordance 10. To
change the destination location, click Browse and choose a different folder. For
example, J:\LexisNexis\Concordance 10. Click Next.

The default location for application data files is C:\Documents and Settings\All Users
\Application Data\LexisNexis\Concordance [version #] (Windows XP) or C:\ProgramData
\LexisNexis\Concordance [version #] (Windows 7).
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7. To start the installation, click Next.
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The installation wizard installs the Concordance files.
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8. Click Finish. 
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Concordance is now installed and can be accessed from your program folder or from the
shortcut icon on your desktop.

To install the evaluation version of Concordance:

1. Run Concordance10_Install.exe directly on the shared server. 

If you are installing Concordance 10.08 and have an older version of Concordance 10.x
already installed, you will be prompted to uninstall the older version before you can
continue the installation process. 

When you uninstall a previous version of Concordance 10.x, the CPL and Database
folders associated with the previous version are not removed.  If you want to remove
these folders, make sure that you back up the folders and then manually delete them.

2. The Welcome dialog box appears. Click Next. 
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3. The Setup Type defaults to Install Concordance 10 Application. Click Next.
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4. Click the Skip Activation button to install the evaluation version of Concordance.

Concordance can be activated later from the Activate Concordance command on the
Help menu. For more information, see To activate Concordance.

To install the full version of Concordance, enter the Serial Number and Activation Code.
For more information, see To install the full version of Concordance Server.
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5. Click OK to acknowledge the You will have the opportunity to activate Concordance 10 from
the application menu bar: Help > Activate message.

6. To print the Limited Use Trial License Agreement, click Print. To agree to the Limited Use
Trial License Agreement, click Yes.
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7. The default folder for Concordance is C:\Program Files\LexisNexis\Concordance 10. To
change the destination location, click Browse and choose a different folder. For
example, J:\LexisNexis\Concordance 10. Click Next.

The default location for application data files is C:\Documents and Settings\All Users
\Application Data\LexisNexis\Concordance [version #] (Windows XP) or C:\ProgramData
\LexisNexis\Concordance [version #] (Windows 7).
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8. To start the installation, click Next.
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The installation wizard installs the Concordance evaluation version.
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9. Click Finish. 
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The evaluation version of Concordance is now installed and can be accessed from your
program folder or from the shortcut icon on your desktop.

To activate Concordance:

An evaluation version of Concordance can be upgraded to a full version from the Activate
Concordance command on the Help menu. You do not need to re-install the software. 

1. Open Concordance Evaluation version.

2. On the Help menu, click Activate Concordance.

3. Type the Serial number and Activation code, and then click Activate.

To receive the serial number and activation code, call Concordance Support at 1-866-
495-2397 or e-mail concordancesupport@lexisnexis.com.

mailto:concordancesupport@lexisnexis.com


Concordance46

© 2018 LexisNexis. All rights reserved.

 

4. Click Accept to accept the End-User License Agreement.

 

5. Click OK to acknowledge the Activation successful. These changes will not take effect until
you restart the application. message.

6. Restart Concordance for these changes to take effect.

Upgrading Concordance

Concordance Server versions 8.x, 9.x, and 10.x can coexist on the same computer. After
installing a new version for the first time, upgrades to the same version, such as hotfixes, and
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upgrades to newer versions can be installed. 

If you are installing the latest version of Concordance and have Concordance 10.7 or
earlier installed, you must uninstall the older version before proceeding with the
installation to ensure that the application files are accessible to Concordance. You do not
need to uninstall versions 8.x or 9.x of Concordance. 

The default install directory for the Concordance application data files is C:\Documents and
Settings\All Users\Application Data\LexisNexis\Concordance [version #] (Windows XP) or C:
\ProgramData\LexisNexis\Concordance [version #] (Windows 7).

When you uninstall a previous version of Concordance, the CPL and Databases folders
associated with the previous version are not removed.  If you want to remove these
folders, make sure that you back up the folders and then manually delete them.

To install Concordance for the first time, see Installing Concordance.

Make sure that you regularly back up your server data and strongly caution users to
regularly back up their data on the workstations. Do not install Concordance Server or
Concordance Workstation unless server data and workstation data has been backed up. 

Do not perform live backups if you are using backup software that locks files, even briefly.
This has been known to cause read/write functions to the database files to fail, and can
cause file synchronization or corruption issues. Check with your IT group and/or backup
solution provider to verify that no file locking occurs before scheduling any backups on
Concordance, Concordance Native Viewer, Concordance Image, and FYI files that are in
use. 

Be aware that anti-virus, firewall, and backup software can often interfere with network
traffic and the locking of files, and in effect, could cause Concordance, Concordance Native
Viewer, Concordance Image, and FYI Server software to crash.

To upgrade Concordance:

1. Backup all data including databases, images, and CPL programs.

2. Run Concordance10_Install.exe directly on the shared server. 

If you are installing the latest version of Concordance and have Concordance 10.7 or
earlier installed, you will be prompted to uninstall the older version and then install
Concordance 10.08.

When you uninstall a previous version of Concordance 10.07 or earlier, the CPL and
Database folders associated with the previous version are not removed.  If you want to
remove these folders, make sure that you back up the folders and then manually delete
them.

3. Upgrade or Repair is selected by default. Click Next.



Concordance48

© 2018 LexisNexis. All rights reserved.

 

The installation wizard upgrades the Concordance files on the same server as the
previous installation.
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5. Click Finish. 
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Concordance is now upgraded to the new version and can be accessed from your
program folder or from the shortcut icon on your desktop.

Converting databases

After upgrading to the latest version of Concordance, any Concordance databases you want to
use in the lastest version need to be converted to the same Concordance version. In
Concordance, you can individually convert databases using the Convert Single Database utility
or you can convert multiple databases at one time using the Bulk Convert Databases to Current
Version utility.

The Convert Single Database utility permanently converts a database to the current database
version. The Bulk Convert Databases to Current Version utility permanently converts all
databases in the selected folder and subfolders to the current database version.

The conversion is permanent and there is no process to convert back to the earlier
version. Be sure to make backup copy of the databases before performing the conversion.

When opening a Concordance version 7.x, 8.x, or 9.x database in Concordance version 10.x,
Concordance prompts you to convert the database to the current version.  

For Concordance version 10, all databases need to be converted to version 10 or later.
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Earlier database versions cannot be opened in Concordance version 10.x. Only database
versions 7, 8, or 9 can be converted to version 10.x.

The conversion process to version 10.x includes a built-in step that checks the TRK file (or the
TAG and TRK for version 8 databases) contents for tag file corruption and attempts to repair
detected tag file corruption. At the end of the conversion process, Concordance generates the
Conversion Report, which is a comma-delimited conversion log file. For more information about
the report, see About the Conversion Report. 

To convert a single database to the current version:

1. Before converting a database, make a backup of all the files in the database.

2. In Concordance 10.x, open a version 7, 8, or 9 Concordance database by clicking Open
on the File menu or clicking Open database in the Databases pane.

A warning dialog box opens notifying you that the database must be converted to
version 10 before it can be used.

3. Click OK.

4. On the File menu, point to Administration, and then click Convert Single Database.

5. In the Open dialog box, browse to and select the database you want to convert, and
click the Open button.

6. Click Yes to convert the database.

If security has not been applied to the database, the database is converted to version
10.x and a Conversion Report is created for the database in the database's directory.

7. If security has been applied to the database, type the database's administrator user
name and password in the Administration dialog box, and click OK. Clicking OK converts
the database to version 10 and a Conversion Report is created for the database in the
database's directory.
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8. To open the converted database in Concordance 10.x, on the File menu, click Open or
click Open database in the Databases pane, and select the converted database.

The Default tag has been removed in version 9 and 10 databases. If the Default tag is
not assigned to a document in a version 8 database, the tag will not appear in the
converted version 10 database. If the Default tag is assigned to a document in a
version 8 database, the tag will be converted and appear exactly the same in the
converted version 10 database.

To bulk convert databases to the current version:

1. Before converting databases, make a backup of all the files in the databases.

2. On the File menu, point to Administration, and then click Bulk Convert Databases to
Current Version.

During the bulk database conversion, the administrator is no longer prompted for the
database administrator's user name and password for each database. To prevent this
feature from being used inadvertently, the Bulk Convert Databases to Current Version
menu selection is disabled until it is enabled on your workstation with a specific registry
key.

Database administrator instructions for enabling the Bulk Convert Databases to Current
Version menu selection are available in the Concordance Release Notes.

3. Select the database folder and click OK. All databases in this folder and its subfolders
will be converted.

http://help.lexisnexis.com/litigation/ac/cn_docs/Release_Docs/HTML/index.html?additional_information.htm
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4. Click Yes to convert the databases.

After the databases are converted, a Conversion Report is created for the databases in
the databases' directory.

The Default tag has been removed in version 9 and 10 databases. If the Default tag is
not assigned to a document in a version 8 database, the tag will not appear in the
converted version 10 database. If the Default tag is assigned to a document in a
version 8 database, the tag will be converted and appear exactly the same in the
converted version 10 database.

Database File Associations in Windows

Unlike previous versions, Concordance version 10.x does not automatically change the
Microsoft Windows file associations for existing Concordance database (.dcb) files. You need to
set the Windows file associations.
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To associate all existing database files with Concordance version 10.x:

1. Open Microsoft Windows Explorer.

2. Right-click an existing Concordance database's .DCB file, point to Open, and then click
Program.

3. In the Open With dialog box, click Concordance 10.

4. Select the Always use the selected program to open this kind of file check box.

5. Click OK.
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About the Conversion Report

The Conversion Report is a comma-delimited conversion log file generated at the end of the
database conversion process when you are converting databases to Concordance version 10.x
or later. When the database conversion completes, Concordance generates and saves the
Conversion Report - [database name]-[date].csv file in the same directory as the converted
databases.     

You can convert individual databases using the Convert Single Database utility or convert
multiple databases at one time using the Bulk Convert Databases to Current Version utility.

For more information about converting databases, see Converting databases.

Report Contents

The Conversion Report contains the following information:

Database name

Path to database

Original database version

Date and time of database conversion

Total number of documents before conversion

Total number of documents after conversion

For each converted database file:

File name

For B-tree files, the number of records before and after conversion

For index files, the total number of dictionary words before conversion, and a note
indicating that a full index needs to be run to gather the total number of words after
conversion

For TRK files, the total number of tag names, total number of documents tagged before
and after conversion, and the number of errors found during the TRK file conversion

Error codes for errors found

User ID of the user entered for Concordance security 

Microsoft Windows User ID of the user converting the databases

Whether Concordance security is enabled

Whether Concordance logon is required

The TRK file row counts in the Conversion Report are determined using the following
method:

When converting version 9.x databases to version 10.x, Concordance counts the distinct tag
names and the number of tag-to-document assignments, and ignores tags that have no
document assignments.

Which Database Files Are Converted?
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The following table indicates how each database file is handled during a database
conversion:

Converted Database Files

File Type Conversion Action

.dcb Converted

.dct Deleted

.dir Not modified

.fyi Not modified (see note about .fyi files)

.fzy  Deleted

.ini Not modified

.ivt Deleted

.key Converted

.layout Converted

.ndx Converted

.sec Converted

.tag Converted

.tex Converted

.trk Converted

.vol Not modified

For more information about database files, see About Concordance database files.

Database Conversion Error Messages

The following table displays the database conversion error messages:
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Database Conversion Error Messages

Cannot delete or rename file.

Cannot open the TRK file. Please check whether it is read only or locked.

Conversion processing canceled.

Error converting ANSI Tags to V10 Unicode version TRK file.

Error converting V9 Tags to V10 Unicode version TRK file.

Error reading DCT file.

Error reading KEY file.

Error reading NDX file.

Error reading TEX file.

Error reading TRK file.

File open error.

Internal application error. 

TAG file validation found mismatched row counts.

TRK file validation found mismatched row counts.

Unspecified error.

Unspecified error by file conversion from V8 to V10.

Unspecified error by file conversion from V9 to V10.

If you are using .fyi files to connect to databases, the .fyi files need to be recreated after
upgrading to Concordance version 10.x and redistributed to the users. 

To create the new .fyi files, click the Save as .FYI file button on the Management tab’s
General tab in the FYI Admin Console. See the Concordance v10 Release Document for more
information about converting single and multiple databases.
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Installing Concordance workstations

Concordance Workstation installs files that are necessary to run Concordance from the server
and creates default registry settings on individual workstations. The Concordance Workstation
installation creates a workstation desktop shortcut linked to the Concordance installation on
your server.

If you are installing the latest version of Concordance and have Concordance 10.7 or
earlier installed, you must uninstall the older version before proceeding with the
installation to ensure that the application files are accessible to Concordance. You do not
need to uninstall versions 8.x or 9.x of Concordance. 

When you uninstall a previous version of Concordance, the CPL and Databases folders
associated with the previous version are not removed.  If you want to remove these
folders, make sure that you back up the folders and then manually delete them.

When performing workstation installs for Concordance version 10.08 & later, you must 
share the application data folder, C:\Documents and Settings\All Users\Application Data
\LexisNexis\Concordance 10 (Windows XP) or C:\ProgramData\LexisNexis\Concordance 10
(Windows 7), for users to access Concordance data. This requirement is due to how
Microsoft Windows 7 now stores and accesses application data, thus making it necessary
for various Concordance files to be moved to allow the applications to function as
expected.

Important: Only the folder listed above needs to be shared, not the entire Application
Data tree.

Make sure that you regularly back up your server data and strongly caution users to
regularly back up their workstation data. Do not install Concordance Server or
Concordance Workstation unless server data and workstation data has been backed up.
 
Do not perform live backups if you are using backup software that locks files, even briefly.
This has been known to cause read/write functions to the database files to fail, and can
cause file synchronization or corruption issues. Check with your IT group and/or backup
solution provider to verify that no file locking occurs before scheduling any backups on
Concordance, Concordance Native Viewer, Concordance Image, and FYI files that are in
use. 

Be aware that anti-virus, firewall, and backup software can often interfere with network
traffic and the locking of files, and in effect, could cause Concordance, Concordance Native
Viewer, Concordance Image, and FYI Server software to crash.

The Concordance Workstation installation does not install the Concordance_10.exe file
onto the workstation. 

When installing Concordance version 10.21, please note that the new E-Documents import
wizard is only compatible with the full installed version of Concordance.  This feature is not
available for a Concordance Workstation installation.

To install Concordance Workstation:
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1. On the server, share the application data and installation folders .

2. Run Concordance10_Install.exe directly on the workstation. 

If you are installing the latest version of Concordance and have Concordance 10.7 or
earlier installed, you must uninstall the older version before proceeding with the
installation to ensure that the application files are accessible to Concordance. You do
not need to uninstall versions 8.x or 9.x of Concordance. 

When you uninstall a previous version of Concordance, the CPL and Databases folders
associated with the previous version are not removed.  If you want to remove these
folders, make sure that you back up the folders and then manually delete them.

3. The Welcome dialog box appears. Click Next. 

 

3. In the Setup Type dialog box, select Create Shortcut to Concordance, and then click
Next.
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4. In the Choose Destination Location dialog box, browse to the network location where
Concordance is installed, and then click Next.  For example, \\Server\Program File
\LexisNexis\Concordance 10. 
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5. In the Choose Destination Location dialog box, browse to the network location where
Concordance(ALLUSERSPROFILE) is stored, and then click Next. For example, \\Server
\Program Data\LexisNexis\Concordance 10.
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6. Review the network directory information and click Next. 

 



Installing 63

© 2018 LexisNexis. All rights reserved.

6. The installation wizard installs the Concordance shortcut icon.

 

7. Click Finish.
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A Concordance shortcut icon is now installed on the workstation desktop. This icon links
to the Concordance server installation.

Installing language packs

To display characters in Unicode within Concordance, the appropriate language packs need to
be installed on the computer.

To install language packs on a Windows XP operating system:

You will need access to the I386 directory on the Microsoft Windows XP installation
media.

1. Open the Microsoft Windows XP Control Panel and double-click Regional and Language
Options.

2. Click the Languages tab.
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3. Select the Install files for complex script and right-to-left languages (including Thai)
and Install files for East Asian languages check boxes. Click OK.

4. You are prompted to insert the Windows XP CD or copy the files from an alternate
location, such as a network server. Click OK.

5. Choose one of these options and enter the path to the I386 directory. You may also
need to specify the I386 language sub-directory. Click OK.

6. Repeat step 5 for the second language pack.

7. Reboot your computer.

To install language packs on a Windows Vista and Windows 7 operating systems:

Microsoft Windows Vista and Windows 7 operating systems use Language Interface Packs
(LIPs). These can be downloaded from the Windows Update Webs site or the installation
media. Once you have installed at least one LIP, you can add or remove more LIPs from the
Control Panel.

1. In the Control Panel, do one of the following:

(Windows Vista) Double-click Regional and Language Options. 
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(Windows 7) Click Change keyboards or other input methods.

2. Click the Keyboards and Languages tab.

3. Under Display Language, click Install/uninstall languages and follow the prompts.

For more information about installing LIPs, click How can I install additional languages at
the bottom of the dialog box or go to the Windows Help and How-to Web page at: 
http://windowshelp.microsoft.com/Windows/en-US/Help/35a1b021-d96c-49a5-8d8f-
5e9d64ab5ecc1033.mspx.

Registry key locations

Concordance version 10.x has new locations for Registry keys. The registry settings are stored
in the same places relative to the new key names:

Registry key locations for Concordance version 10.x are:

HKEY_CURRENT_USER\Software\LexisNexis\Concordance 10 (32-bit)

HKEY_LOCAL_MACHINE\SOFTWARE\LexisNexis\Concordance 10 (32-bit)

HKEY_LOCAL_MACHINE\Software\Wow6432Node\LexisNexis\Concordance 10\Settings (64-
bit)

Concordance version 10.x also has a new Registry value for the snapshot path:

HKEY_CURRENT_USER\Software\LexisNexis\Concordance 10\Settings\AutoSave

It holds the path to the snapshot for the current user, which is:

<drive>:\Documents and Settings\<username>\My Documents\Concordance 10\autosave.snp

Registry key locations for Concordance version 2007 are:

HKEY_CURRENT_USER\Software\LexisNexis\Concordance

HKEY_LOCAL_MACHINE\SOFTWARE\LexisNexis\Concordance 2007

HKEY_LOCAL_MACHINE\SOFTWARE\LexisNexis\Concordance

The Concordance version 2007 registry key for the snapshot path is:

HKEY_CURRENT_USER\Software\LexisNexis\Concordance\Settings\AutoSave

Registry key locations for Concordance version 8.x are:

HKEY_CURRENT_USER\Software\Dataflight\Concordance

HKEY_CURRENT_USER\Software\Dataflight Software, Inc.\Concordance

HKEY_LOCAL_MACHINE\SOFTWARE\Dataflight\Concordance\8.2.4.24

http://windows.microsoft.com/en-US/windows-vista/How-do-I-get-additional-language-files
http://windowshelp.microsoft.com/Windows/en-US/Help/35a1b021-d96c-49a5-8d8f-5e9d64ab5ecc1033.mspx
http://windowshelp.microsoft.com/Windows/en-US/Help/35a1b021-d96c-49a5-8d8f-5e9d64ab5ecc1033.mspx
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Performing silent installs

When you need to install and activate the full version of Concordance on numerous machines,
you can save time by running silent installations of Concordance on each machine. 

Silent installations use a setup.iss InstallShield® Silent response file to run an installation.
Silent installations install applications without prompting you for input during the installation.

To install Concordance using a silent installation, you will first need to create a setup.iss file.
This setup.iss file only needs to be created once. When you are creating the setup.iss file, you
will be running a normal Concordance installation on a machine and will be recording each step
and setting of the installation process for the setup.iss file. After the setup.iss file is created,
this file can be used any time you want to run a silent Concordance installation on a machine.  

Please check to ensure you are not exceeding your License Agreement when you are
creating the setup.iss file for installing Concordance. Enterprise Client Licenses are the
only licenses that allow installing full Enterprise Network Licenses on multiple servers or
workstations. 

When upgrading to the latest version of Concordance, you must uninstall the older version
before proceeding with the installation.

To create a setup.iss file for installing Concordance:

1. Click Start, and then click Run.

2. Type cmd in the Open field and click OK to open the cmd.exe command prompt.

3. Do one of the following:

Type the path to the Concordance_<version#>_Install.exe file followed by -r and
press Enter. 

For example: w:\concordance_<version#>_install.exe -r

Run the Concordance_<version#>_Install.exe directly on the workstation and
complete all of the installation and activation steps.

When the installation is complete, the setup.iss file is created in the \WINDOWS
subdirectory. 

The setup.iss file contains a record of the actions you performed for each installation
dialog box.

Best practice is to store the setup.iss, and the Concordance installation and license files
together in a network folder that you can access from each machine on which you will be
running a silent install.

4. Create a network folder and add the following files to the folder:

setup.iss

Concordance_<version#>_Install.exe

Concordance.license file
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The Concordance_<version#>.license file is located in the Concordance application data
directory. The default directory is C:\Documents and Settings\All Users\Application Data
\LexisNexis\Concordance 10 (Windows XP) or C:\ProgramData\LexisNexis\Concordance 10 
(Windows 7). The Concordance_<version#>.license file is a hidden file. 

If you cannot see the file, you will need to display hidden files, using the Show hidden
files and folders option for Windows. 

To install Concordance using a setup.iss file:

1. Click Start, and then click Run.

2. Type cmd in the Open field and click OK to open the cmd.exe command prompt.

3. Type [path to the Concordance<version#>_Install.exe file] -s -f1[path to the
setup.iss files] and press Enter to silently install Concordance. 

For example: w:\concordance<version#>_install.exe -s -f1w:\setup.iss

The -s parameter tells InstallShield that you are running a silent operation, and the -f1
parameter indicates where the setup.iss file is located. Note that there is a space
between the -s and -f1 parameters, but there is no space between -f1 and the path to
the setup.iss file.

Silent installation programs do not display error or status messages, such as Setup is
now complete, during the installation. By default, silent installation status and error
information is recorded in the setup.log file. The setup.log file is automatically created in
the same directory where the setup.iss file is located.

If the setup completes, the setup.log file should contain the following information:

[InstallShield Silent]
Version=v7.00
File=Log File
[ResponseResult]
ResultCode=0
[Application]
Name=Concordance <version#>
Version=xx.xx.xx.xx
Company=LexisNexis
Lang=0009|

Result codes indicate whether an installation was successful or there were errors during
the installation. A 0 in the ResultCode field indicates the installation was successful.

For more information about the setup.log file, including a list of result codes and their
definitions, see the “Checking for Errors Using the Setup.log File” Help topic in following
Web site: http://helpnet.flexerasoftware.com

Click the Search button in the Flexera Software Web site and search for setup.log to view
the Help topic and other relevant Help topics.

4. After Concordance is installed, add a copy of the Concordance_<version#>.license file
to the directory where the Concordance_<version#>.exe file was installed. 

http://helpnet.flexerasoftware.com
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The default directory is C:\Documents and Settings\All Users\Application Data\LexisNexis
\Concordance 10 (Windows XP) or C:\ProgramData\LexisNexis\Concordance 10 (Windows 7). 

Customizing the start-up view

In Concordance, there are four settings you can define to customize the what you will see
when you open Concordance:

Initial browse path

Default database view

Most recently used list

Workspace tab display

To customize the Concordance start-up view:

1. On the Tools menu, click Preferences to open the General tab in Preferences dialog
box.

2. In the Initial Browse Path field, click the ellipsis (...) button and browse to the folder you
want to be the initial folder that opens when browsing for a file or opening a new
database. 

For example, entering C:\LexisNexis\Databases\Concordance 10 opens this folder when
clicking Open database in the Databases task pane.

3. In the Default view field, select Browse or Table.

The view you select is displayed when you open a database in Concordance. 

4. In the Number of MRU items field, type or scroll to the number of files to list in the most
recently used (MRU) file list. 

Your MRU list is displayed in the File menu and the Recent panel in the Databases task
pane. The maximum number of files you can display is 9.

If a user's MRU list in the File menu or Databases task pane is blank, your company may
have a policy preventing the user's computer from writing to the MRU registry key:

HKEY_CURRENT_USER\Software\LexisNexis\Concordance 10\Recent File List (32-bit)
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By default, the Workspace tab is displayed and contains links to the LexisNexis Web
site. You can customize your Workspace tab to display internal or external Web pages
simply by adding a link to an external HTML web page or to a locally stored .HTM or
.HTML file with information you’d like to publish for user reference.

5. In the Workspace section of the General tab, the Enable workspace check box is
selected by default. To continue displaying the Workspace tab in Concordance, leave
the Enable workspace check box selected. If you do not want to display the Workspace
tab, clear the check box.

6. If you want the Workspace tab settings to apply to all users in all databases, in the
Apply to field, choose <All databases, all users>. If you only want the Workspace tab
settings to only apply to the local user, choose <local user only>. 

7. To add a link to an external HTML Web page, in the URL field, enter the Web site URL. Be
sure to include http:// or https:// in the URL. For example: http://lexisnexis.com/
concordance.

To add a link to an internal internal .HTM file located on your server, in the URL field,
enter the full UNC path. For example: J:\LexisNexis\Internal_Links.htm OR \\MyServer
\MyFolder\myhtm.htm.

http://lexisnexis.com/concordance
http://lexisnexis.com/concordance
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8. Click OK to save your changes. 

Your changes will not go into effect until you restart Concordance.

For more information about the other Concordance Preferences dialog box settings, see 
Defining preferences.
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